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~Welcome

This quick reference guide provides an easy way to locate any (and all) parameters and
jobs available in the DX7 II fd/d.

It is comprised of two basic sections:

The Edit Button Quick Reference Guide provides a chart of all the parameters/jobs for
each button.

The Individual Button LCD Displays show all of the possible LCD Displays that can be
called up with each of the buttons. To the right of the displays, the range of the
parameters or the available options are provided.

At the end of the booklet, a blank voice data chart and a blank performance data chart are
provided. Please feel free to photocopy these two pages so that you can document any
edits you make for your own custom voice library.

For continuing information concerning the DX7 II fd/d, consult AfterTouch, the official
publication of the Yamaha Users Group. Many advanced functions will be discussed in its
pages in the coming months. There will also be information concerning the availability of
other materials concerning more advanced applications. To receive a free copy of After-
Touch every month, send your request to AfterTouch, P.O. Box 2338, Northridge, CA
91323-2338. On your letter or postcard, be sure to indicate that you are the owner of a
DX7 11 fd/d.
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Voice parameters
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Voice Edit parameters

Performance parameters




MIDI parameters




Voice
Buttons

Button 7 LCD Display
ALGORITHM Algorithm (1 - 32)
39 >Al19>Fbl >0sc.sync >Transpose >Uoice nhame
7 15 7 off midC= C3 Warm St9 A ] 7Fbl
Feedback Level (0-7)
»Jsc. sd9nc
Oscillator Sync (off, on)
. *Transpose
~ Transpose (mid C = C1to C5)
*Uoice name
Voice Name (710 character name)
Button 8 LCD Display
OSCILLATOR . I
Oscill Mod , fi
20 OP1 Osc sMode >Coarse>Fine >Detune scillator Mode (ratio, fixed)
8 algld 111111 fixed 1.820Hz +@ ‘LCoarse
Coarse Frequency (varies: see text)
*Fine
Fine Frequency (varies: see text)
*Detune
Oscillator Detune (-7 to +7)
Button 9 LCD Display
EG >Rs .
a1 OP1  EG >Rs>R1>R2>RI>R4>L1>L2>LI>L4 | P Sealng @-7)
9 [
21 algls 111111 @ 45 35 16 48 99 99 99 0@ ~j>R1 >R2  >R3 >R+%

Operator Envelope Rates 1 -4 (0-99)

*L1  >L2 >L3 >L¢4
Operator Envelope Levels 1 -4 (0-99)



Button 10 LCD Displays

0P1

algls 111111

Outlul >Scaling mode
normal

OF1

algl3 111111

Outlul >Level>Ld >Lc

97 31 -lin

>Be  »Rc »Rd
R2 -1in B

OP1

algls 111111

Outlul >Scaling node
fractional

0P1

Outlul >0fst

algls 111111 + @

> C-2-» C¥#-1-»
183 187

Button 11 LCD Display

SENSITIVITY

0P1

algls 111111

Sens
1

>Uelocity >Ams >Pms(all O
T

1

|

>Scaling mode
Scaling Mode (normal, fractional)

>Level
Operator Output Level (0 -99)

>Ld
Left Scaling Depth (0-99)

*Le
Left Scaling Curve (-fin, -exp, +exp, +lin)

>Bm
Break Point (A-1 to C8 by half steps)

>Rec
Right Scaling Curve (-in, -exp, +exp, +lin)

>Rd
Right Scaling Depth (0 - 99)

>Scalingd mode
Scaling Mode (normal, fractional)

>0fst
Fractional Scaling Offset(-127 to +127)

> C-2-»
Scaling Level for key range (0 - 255)

: >Jelocity

Velocity Sensitivity (0- 7)
>Ans
Amplitude Modulation Sensitivity (0 - 7)

»Pms(all OP)
Pitch Modulation Sensitivity (0 - 7)



Button 12 LCD Display

>Wave
LFO Waveshape
(triangle, saw down, saw up,

sine 30

LFO >Wave>Speed>0elay>Mode>Pnd>And>Sun
15 multi

c
off

square, sine, s/hold)

>Speed
LFO Speed (0 - 99)

Button 13 LCD Display

PITCHEG

>Delay
Delay before LFO begins (0 - 99)

>Mode
LFO Mode (single, multi)

>Pnmd
Pitch Modulation Depth (0-99)

>Amd
Amplitude Modulation Depth (0 - 99)

>Sunc
LFO Sync (off, on)

>Rn9g

Ped >Rna>Uel>Rs>R1>R2>R3>R4>L1>L2>L3>L
Boct off @ 84 95 95 60 58 5@ 58 S

4 Octave Range (12, 1, 2, 8)
@ >Uel
Velocity (off,on)
>Rs

Rate Scaling (0-7)

>R1 >R2 >R3 >R4
Pitch Envelope Rates 1 -4 (0-99)

>L1 >L2 >L3  >L4
Pitch Envelope Levels 1 - 4 (0-99)



Utility Buttons

TUNE

Button 14 LCD Displays

Memory protect >INT >CRT
am an

tuning

Hicro tuning
*Coarse>Fine

>rro>> [-24<<<< CH-2
C-1+ @{ 939) @

Recall esdit >Upice *Perf. >Micro tuning

Initialize >UoiceA *UoiceE >FPerformance

>Master tuning
Master Tuning (-64to +63)

>INT

Internal Memory Protect (off, on)

>CRT
Cartridge Memory Protect (off, on)

>Coarse
Coarse Frequency (C#-2to G8 by half steps)

>Fine
Fine Frequency (-42 to +42)

>Uoice
Recall Voice Edit

>Perf.
Recall Performance Edit

>Micro tuning
Recall Micro Tuning Edit

. >Uoicef

Initialize Voice Bank A

>UoiceB
Initialize Voice Bank B

>Performance
Initialize Performance



CARTRIDGE

47
15

Button 15 LCD Displays

Cartridde
Bank 1

Cartridge
Uoice & Perf.

Cartridde »Bank
Fractional SC.

>Format
FK5-¥

Cartrid3e sBank
Hicro tuning 4

*Format

nTT-Y

Bank (1-4)

>Format
Format (DX7-2, FKS-Y, MTT-Y)

. >Bank

Bank (1-4)

_ >Format

Format (DX7-2, FKS-Y, MTT-Y)

>Bank
Bank (1-4)

>Format
Format (DX7-2, FKS-Y, MTT-Y)



DISK

Button 16 LCD Displays

16

Disk >Formnat >Back ue >Free butes
#% Set disk and mush [ues)

Oisk INT >Dir >Save >Load >Del >Rename
%% Set disk and push [ues]

Disk CRT >:D0ir>Save>Load>0el>Rename>Bank
** Set disk and push [uwes] 1

Disk MOR >0ir >In >0ut >0el >Renane
**% Set disk and push [ues]

>Format
Format Disk

>Back um
Back Up Disk

>Free butes
Free Files On Disk (71-44)

>Dir
Internal Files Directory

>Save
Save Internal File

>Load

Load Internal File

>Del

Delete Internal File

>Rename
Rename Internal File

>Dir

Cartridge Files Directory
>Save

Save Cartridge File
>Load

Load Cartridge File

>Del
Delete Cartridge File

>Rename
Rename Cartridge File

>Bank
Cartridge Bank (1-4)

>Dir
MDR Files Directory

>In
MDR File In

>0ut
MDR File Out

>Del
Delete MDR File

>Renane
Rename MDR File



Voice
Edit Buttons

KEY MODE

Button 23 LCD Displays

>Key mode

55
23

palurhonic

>Key mode *Unison detune

PITCH BEND
PORTAMENTO

unison moho 8

Button 24 LCD Displays

Pitch bend >Range >Step >Mode
12 6] high

Portamento >Nade >Ster >Time (5)
sus-kKey P retain 5] I}

Random pitch  >0epth
1

}:>Step

>Key mode
Key Modse

(polyphonic, monophonic,
unison poly, unison mono)

>Unison detune
Unison detune (0-7)

(appears only when Key mode
= unison poly or unison mono)

2 >Rande

Pitch Bend Range (0-12)

Pitch Bend Step Range (0- 12)

>Mode
Pitch Bend Mode (normal, low, high, key on)

>Node
Portamento Mode
(sus-key p retain, sus-key p follow)
>Step
Portamento Step Range (0-12)

>Time

Portamento Time (0-12)

>Demth
Random Pitch Depth (0-7)



Button 25 LCD Displays

Breath control

( 2)

>Pmod>Amod>EGbias>Pbias

]

@

@ + 0

After touch

>Prnod >Amod >EGbias >Phias

@

99 + 0

Modulation wheel >Pmod

(1)

[E]

>Amod

G -

>EGbias
%}

Envelope Generator Bias (0-99)

>Pbias
Pitch Bias (-50 to +50)

>Pmod
Pitch Modulation (0 - 99)

>Amod
Amplitude Modulation (0-99)

:>EGbias

Envelope Generator Bias (0 -99)

>Pbias
Pitch Bias (-50 to +50)

>Pmod

Pitch Modulation (0 - 99)
>Amod

Amplitude Modulation (0-99)
>EGbias

Envelope Generator Bias (0-99)



FC1
FC2

Button 26 LCD Displays

{4 aff B B8 99 0

Foot control 1 >C51:Prod>Anod>EGhias>Ual

. Control Slider 1 (off, on)
?:>Pmod

Pitch Modulation (0-99)

>Amod
Amplitude Modulation (0-99)

Foot control 2 >FPmod >Amod >EGbias >Usl
(7) @ @ a @

- >EGbias
i Envelope Generator Bias (0- 99)

>Uol
Volume (0-99)

MIOI IN control >Pmod »Amod >EGbias »Uol
[11] @ @ a @

>Pmod
Pitch Modulation (0 - 99)

>Amod

Amplitude Modulation (0-99)

>EGbias
Envelope Generator Bias (0 -99)

>Uol
Volume (0-99)

>Prod
Pitch Modulation (0 - 99)

>Amod
Amplitude Modulation (0 -99)

>EGbias
Envelope Generator Bias (0 - 99)

>Uol
Volume (0-99)



Performance
Edit Buttons

Button 27 LCD Displays
o8 R
59 :  Bank A (off, on)
27

>Select >A >B
Portament on on

>Select
0P2 Freauency fine

Select (see Select Table)

>R
i Bank A (off, on)

*>Select >A  >B
0P2 Frequency fine

Bank B (off, on)

>Select
Select (see Select Table)

>A
Bank A (off, on)

>B
Bank B (off, on)

-14 -



Button 28 L.CD Displays

VOICE MODE

1 >Uoice mode
single

60
28

Uoice B

>Uoice mode
Voice Mode (single, dual, split)

>Total volume
99

>Total volume
Total Volume (0-99)

>Uoice mode
dual

>Uoice mode
Voice Mode (single, dual, split)

Uoice B
INT 2

canos

>Total wvolume

>Total volume

90 + 0

Total Volume (0-99)

© >Balance

Balance (-50 to +50)

>Dual detune
)

= >Dual detune
+  Dual Detune (0-7)

Uoice A
INT 1

Uoice B
INT 2

>Uoice mode
Voice Mode  (single, dual, split)

>Balance
+ 0

>Total volume
90

Total Volume (0 -99)

>Balance

Balance (-50to +50)

>Split point
C3

Split Point (C-2 to G8 by half steps)

215 -




MICRO TUNE

Button 29 LCD Displays

61
29

Micro tuning >Table select
Preset 1 Equal temperament

>A >B
off off

>EG forced damp

| off

Note shift

>Performance name

Warm Stringd Section

Button 30 LCD Displays

AN >Mode
1 A:on B:ion

LFO

>Select

| PAN EG

*R1>R2>R3>R4>L1>L2>L3>L4

-16 -

99 99 99 99 5@ 30 5@ 56

>Table Select )
Tuning Table (Preset 1-11, User 1-2, Cart 1-63)

>A
Table Bank Switch (off, on)

>B
Table Bank Switch (off, on)

>EG forced damp
EG Forced Damping (off, on)

>A
Bank Note Shift (-24 to +24)

>B
Bank Note Shift (-24 to +24)

>Performance name
Performance Name (20 character name)

>Mode
Pan Mode (0-3)

>Range
Pan Range (0-99)

>Select
Pan Select (LFO, Velocity, Note number)

>Rl  >R2 >R3 >R¢4
Pan Envelope Rates1 -4 (0-99)

>L1 »L2 L3 L4
Pan Envelope Levels 1-4 (0-99)



MIDI Buttons

MIDI
1

31

Button 31 LCD Displays

MIDI >Note on/off >PC trns mode >Local
all normal on

Prodram swil -1 [ =-1>C110[02)1[ 3]
chan9e trns #: - Ga1 0662 063

Channel >Trns ch Rcu ch>A >B >0Omni
messades 1 1 1 on

Contral HMIDI IH control >R »>B LS >1 >2
number 11 12 g 18

>Note on/off
Note Selection (all,0odd, even)

>PC trns mode
Program Change Transmit Mode
(off, normal, programmable)

>Local
Local Mode (off,0n)

>0 11 021 [ 3]

Program Number to Send (007 - 128)
>Trns ch
Transmit Channel (7 - 16, off)

>A
Receive Channel A (1 - 16, off)

>B
Receive Channel B (71 - 16, off)

>0mni
Omni Mode (off,on)

>A

MIDI In Controlier A (11-31)
>B

MIDI In Controller B (17 - 31)
>1

MDI In Slider 1 (5-31)
>2

MIDI In Slider 2 (5 - 31)



Button 32 L.CD Displays

>Device number >Receive block

1-32

MIDI out

MIDI out

Uoice >Edit buf >1-32 >33-64

Transmit edit buffer data 7

Per formance >Edit buf >INT

Transmit edit buffer data ?

— m—

MIDI out

Hicro tuning >Edit buf>INT>CRT

Transmit edit buffer data ?

MIDI out

>System setup
Transmit system setup data?

>Device number
Device Number (7 - 16, off)

>Receive block
Receive Block  (1-32,33-64)

>Edit buf
Transmit Voice Edit Buffer

>1-32
Transmit Voice Data 1-32

>33-64
Transmit Voice Data 33-64

>Edit buf

Transmit Performance Edit Buffer

>INT

Transmit Internal Performance Memory

>Edit buf
Transmit Micro Tuning Edit Buffer

>INT

Transmit Internal Micro Tuning Memory

>CRT

Transmit Cartridge Micro Tuning Memory

>Sustem setup
Transmit System Setup



-6[-

Voice name .
(D) 7 Date :  /  J

Jaey)) ejg(] 9010A jue[q

ALGORITHM OSCILLATOR|OP | 2 3 4 5 6 Key mode Foot control |
ALG Mode Key assign mode P. MOD
FBL Coarse+Fine Unison detune A. MOD
0OSC.Sync Detune Pitch Bend EG. B
Transpose E G oP | 2 3 4 5 6 Range P. Bias
L F 0 RS Step Foot control 2
Wave RI Mode P. MOD
Speed R2 Portamento A. MOD
Delay R3 Mode EG. B
Mode R4 Step P. Bias
PMS Ll Time MIDI IN control
PMD L2 Random pitch S. P.MOD
AMD L3 Modulation Wheel A. MOD
Sync L4 P. MOD EG. B
Pitch E G Output Level |OP | 2 3 4 5 6 A. MOD P. Bias
Range " EG. B
Veloclty Scaling mode o Breath Control
RS Output Level P. MOD
RI LD A. MOD
R2 LC EG. B
R3 BP P. Bias
R4 RC After Touch
Ll RD P. MOD
L2 Sensitivity |OP| | 2 3 4 5 6 A. MOD
L3 Velocity EG. B
L4 AMS P. Bias




Blank Performance Data Chart

< e

Performance name :

Voice mode

Voice No(name)

Total volume

Balance

Dual detune

Split point

Sustain foot switch

Foot switch

( )RNG

Continuous slider |

( )

Continuous slider 2

( )

Micro tuning table select

( )
Key=

EG forced damping

Note shift

PAN mode

PAN range

PAN select

PAN EG

R1

R2

R3

R4

LI

L2

L3

La

220 -




